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Chapter 1 - Power Apps Overview

CHAPTER 1 - POWER APPS OVERVIEW

1.1  Types of App

. . i New app
When you're creating apps in Power Apps, you have Most people will choose
a choice of 3 types, as shown on the right: a Canvas app. T—&| Canvas o
Model-driven
Portal
These are used as follows:

Type of app

Notes

Canvas

With a canvas app you start from a blank screen, can link
to any types of data source and have free rein to get your
app to do whatever you want.

Model-driven

A model-driven app must be based on a Common Data
Services model, usually Dynamics 365. You’re much more
restricted in what you can do, and many of the forms are
created for you based on the structure of the model to
which you’re connecting.

Portal

A portal app must also be based on a Common Data
Services model. Portal apps are the newest of the three

types, and allow you to create a

pps for external users.

This courseware will focus exclusively on canvas apps.

Examples of Apps

Here are two simple apps you could create using Power Apps:

My favourite films O

A Few Good Men  Drama 15 & . A
Apollo 13 History PG
Bee Movie Animation U
Cabaret Musical 15

This app lets you list out your favourite films, change their details and even
add new films. The films could be stored in a cloud-based Excel workbook, a

SQL Server database linked by

a gateway, a SharePoint list or any other data

source accessible from the cloud.

Edit this film

Film: |A Few Good Men ‘

Genre: | Drama ]

Certificate:
Save changgs

Marmite - love it or hate it?

This very simple app uses s five-star
rating control, one of many such gizmos
that make Power Apps apps such a
pleasure to design and use. Clicking on
the button takes you to a second screen
giving your vote:

Thank you for voting -
you gave Marmite 3
outof 5

© Copyright 2023
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Chapter 1 - Power Apps Overview

1.2 What you Need

To Design your Apps

You can run Power Apps either through a modern
browser like Edge or Chrome, or else through a desktop
program called Power Apps:

The desktop version of Power Apps will be deprecated soon.

https://powerapps.microsoft.com/

To Run your Apps

You can run your apps in any modern browser, and also on
your Android or Apple phone:

a) Download the Power Apps app from the Google or
Apple store.

You don’t need to bother downloading it; instead just go to: v

= Power Apps

Open

MNew ©F

Account

Flows =

b) You can run any app by scrolling up or down the list to find it,
then tapping on it.

Connections Cf

click to download

click to download

Marmite
Trainer Trainer
wiseowl.co.uk (default)

Best films
Trainer Trainer
wiseowl.co.uk (default)

Actor List
Trainer Trainer
wiseowl.co.uk (default)

Wise Owl Expense system
Trainer Trainer

wiseowl.co.uk (default)

A | Wise Owl
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Chapter 1 - Power Apps Overview

1.3 Getting Help

Here are the sources which Wise Owl found useful when learning Power Apps.

The Microsoft Website

Yes, really! Microsoft have put
a lot of effort into providing
tutorials on using Power Apps =
(the one on edit forms is
especially good):

fny Home

I m Learn

/ﬁ\pps

a) Click on this tab on the left-

b) Click on this button to bring
up the main help page.

hand side of the Power Apps —+ Create

home page.
B Data N
o Flows
&} Chatbots v

connect to your data. Discover how
make both model-driven and canvs
based apps with these resources.

=l

Guided learning

Build your skills with short interactive
courses.

Help topics

Get in-depth information.

Explorg

Get support

Get started

Take an interactive tour

Opening Template Apps

There are a number of sophisticated pre-built apps
that you can open and inspect:

a) Click on this button on the left side of the Power Apps
home page, and choose to create an app.

b) Scroll down to see the apps already created for you to
use, and choose one you like the look of!

i1 Power Apps

All Office
{1 Home -
Learn _
B Apps
I-I- Create
B Dota o Power Apps Training for Office
& Canvas app @
o Flows
@ Chatbots

o§ Al Build

Power Apps Training

& Carvas app

And finally, an honourable mention to Shane Young. There are many tutorials on
Power Apps online, but Shane’s were the ones we found most useful (plus he’s
engaging company, even if you will learn more about his dog than you want to!).

© Copyright 2023
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Cha

pter 2 - Creating

CHAPTER 2 - CREATING

2.1 Our Simple Starter App

This chapter (and the next two) will show
you how to create the following app:

When you choose a rating and click on the voting
button, the app tells you what you voted. Note
that for this simple app nothing is saved!

This app contains two screens:

Marmite - love it or hate it?

> Thank you for voting -

you gave Marmite 1
outof 5

Screen

Name we’ll use

Notes

This is the voting screen, where we record

scrVoteForm whether we like Marmite (the author doesn't).
b G A A ko
[ voicoon ]
o . .
This is the results screen, reflecting back our
scrResults

preferences.

Note that we’ll (mostly) use Modified Hungarian Notation to name things in our app
(a fancy way of saying that the first 3 letters of the thing’s name denote what sort of
a thing it is — so scr for Screen, for example).

© Copyright 2023
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Chapter 2 - Creating

2.2 Working with Apps

Creating Apps

Assuming that you're in Power Apps, here’s how to create a new app from the home screen.

You can also create an app using the New app Power Apps
button from the Apps menu. This gives menu = 4 Newapp ¥ <)
options which do the same thing, albeit formatted PR b
differently for some reason. Apps
O rearn
I =) Apps Apps Compons
- A/
Choose to create an app:
Power Apps Create
) Home Create your app
— = (2]
O rean
Start from = =
B Apps —
l + Create Blank canvas app

@ Datavbrse

&

o Flows

Create an app froxy scratch and

© Chatbot then add your data

(B Al Builder

\

Start with a blank sc

creste | '\ Create

a) Choose this b)
menu option.

Choose to create c)
a new blank app.

Choose to create a canvas app (you can also see a
good description of model-driven and portal apps here).

Canvas app from blank

App name .

d) Give your new app a name (we’ve called
this one Marmite questionnaire).

Format

) Table

@ Phone

YA

Design the app you want, and connect it to hundreds of
data s

& Canvas app

e) Decide whether to create a tablet or
phone app (note that you can’t change
this later). If you're not sure, it's probably
better to create a tablet app, since Power
Apps will usually do a good job of
shrinking a tablet app to display sensibly
on a phone. Many people create two
different versions of their apps (one for
viewing on a tablet and one for viewing
on a phone).

apps.

For some reason Power Apps is more inclined to add search boxes at the top of
screens when you create a mobile app using a template, as opposed to creating a
tablet app using a template. Most of the examples in this courseware use mobile

© Copyright 2023
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Chapter 2 - Creating

If you’re successful, you can now see Presumably the fact Welcome to Power Apps Studio
your app' that you're reading Here are a few ways to start building an app from a blank

canvas.

this courseware
means you can skip
the tutorial offered ....

Create a gall

Take an interactive tour T e how an app is built &

Saving your Apps

It's a good idea to save your app as soon as you've created it:

33X Power Apps a) Choose to go to b) Choose to e
the File menu. save the file
with a new
name. New
[J New screen ~
Open
Save as Account
lfeif;‘prps Marmite questionnaire V\
i Settings
This computer - s " N
ﬂ Save a copy to my comptyter
Mv anns and comnonent libxarieg
Y Save
c) Choose where you want to save d) Give your new
your file (your local computer, or app a sensible
your cloud account). name. Save aE}
Marmite questionnaire
Environment: wiseowl.co.uk (default)
Saved: 13/08/2020, 14:36:36
v/ All changes are saved. e) If you choose to save your file to Power Apps in the cloud (as you
usually will), this dialog box will appear. Don’t worry for now
See all versions 4] about why you might have different versions of your app!
Auto-save will prevent you losing much work if you close down your app without
saving your changes, but be warned that this only kicks in once you’ve saved your
file to start with.

Training
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Chapter 2 - Creating

Opening Apps

Once you've created one or more apps, here’s how to open each:

i1 power Apps Click on the app you
want to edit, then

= + Newapp v <Way 12 Share = Export package (preview) @ Add to Teams| choose one of the two
options shown boxed.
1 Home .
Apps If you click on the
@ Learn name of the app, this
Apps Component libraries (preview) won’t work (It will play
| & Apps the app, rather than
allowing you to edit it).
~+ Create F  Name gy )
& Data e u Marmite
" Flows (] Marmite questionnaire
& Chatbots N Appy McAppFace Vi Edié
°§ Al Builder et | I A P D Play Welcome to Power Apps Studio
Here are a few ways to get started if this is your first time
editing an app.
You may then have to skip the tutorial showing how to work with apps (depending on See a preview of this app >
whether you've ticked the box to ask not to see this question again). I e
[T] con't show me this agzin Skip

Important note: you can only edit one app at
a time in Power Apps.

Closing Apps

To close an app, just close its browser page:

E Marmite - Saved (Unpublished) % + Leave site?
tps://uk.create.powerapps.cofm/studio/ Changes you made may not be saved.
C FBook XWord ll/StartP: 7T &
Bl FBook T ord  ogg/StartPage B - m Cancel
\
When you click on the cross on a browser ... Power Apps will warn you if you have
tab to close the tab ... unsaved changes.

Training
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Chapter 2 - Creating

2.3 App Settings

When you create an app, you can give it a
name and an icon, and choose whether
you want to view it in portrait or landscape
mode (among other useful settings):

12t Power Apps | Canvas

& Back | File
s 1

ome Insert

Changing the Name and Icon

Begin by choosing the File menu, then choose Settings
from the menu which appears on the left of your screen.

Here’s how to change the name of General
your app, and assign an icon to it: Settings
Name
General Marmite questionnaire ¢~
Click on this link to change your app’s .
name: Display escription
Asks user for their views on Marmite - love
Edlt app name b4 it, or hate it?
Support £
App name App icon
Marmite questionnaire] |
Choose an icon from the list (you can con
also browse to your own, as we've [
done here). P selecticon 2| + Add image

Setting Screen Size (Tablet Apps Only)

If you’re building a tablet app, you can say how

; e Settings
blg your target screen Is: = Select the screen size and arientation for your app.
General
a) Choose to show the Display settings from the
) pay 9 ’/leisplay

File > Settings dialog box.

b) Say what size of screen you’re aiming for (you
should also consider the settings shown on the
next page at this point).

Sre

Display

Upcoming features

Support

Orientation

[3 Landscape v
Size
16:9 Default dm d ‘
16:9 Default
© Copyright 2023 Page 15
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Chapter 2 - Creating

Changing and Locking Orientation

Apps are much easier to design if you can fix their a) Choose to change the Settings
view to either landscape or portrait: display settings for
your app. = |
enera

b) Choose whether to view it in portrait or landscape
mode. Display

Upcoming features

c) Suppose you are designing a phone app, and a
user runs it on their large laptop screen. What
should happen? If you have Scale to fit turned On
(as here), Power Apps will increase the size of all of

your controls to fill the screen, which will probably Display
look strange; if you have it turned off, Power Apps ) i
will use responsive layout to redraw controls on the QOrientation
screen according to its size. This will give better
- . 3 Landscape 4
results, but will mean that you have to consider
responsive screen layout throughout your app i
design. ze
‘ 16:9 Default 4
- ] . Scale to fit
d) Locking your screen aspect ratio makes designing
apps easier, but means your apps may look strange Scales the app to fit available space. Turning this off allows
on (for example) square screens. screens and controls to fill the available space.
@ o
e) Locking the orientation means that when a user Lock aspect ratio

rotates their phone, your app won’t change. If you

> . ; oy Locking this automatically maintains the ratio between height
turn this option on, you’ll need to confirm it:

nd width to prevent distortion.

Lock orientation @ on

Locking the orientation may reduce the accessibility of

Lock orientation
your app for some users.

Locking orientation keeps the screen in its current orientation,

‘7C i ‘ yen when the device is rotated.
ncel ontjnue
—J‘L'— On

For an easy life, turn all of the options on (as shown above). To design a
professional app, you should probably turn all 3 options off and build responsive
design into every screen of your app (no small undertaking), as described in a
separate chapter later in this courseware.

Training

© Copyright 2023 &j Wise Owl Page 16

.
pe



Chapter 2 - Creating

24 The Power Apps Screen

Here’s how the Power Apps screen looks:

Click on this icon to hide or
display the left-hand menu bar.

The Power Apps menu (here

we’re looking at the Home tab).

Tree view allows you to see each
screen and its constituent parts.

Power Apps | Canvas

wiseowicourses.co.uk (d... Q & ? \2/
Marmife questionnaire | [{9 | {) Q‘ D (Q\, (-)
EE Border v Vv | B8 Reorderv & Align v
N
ICON >
icnExit
Properties  Advanced deas
Icon X Cancel hd
Rotation 0
Display mode Edit v
Visible o @D
Position 576 21
X ¥
Size 3 39
Width Height
Padding 0 0
Top 8ottom
0 0

_|WI < I Color

Environment N

Left
/‘ A«

& Back | File/ Insert View Action Home Settings
) New scréen v ‘ &2 Theme v Av &, i
Or v = fxv it(false)
= Tree view X
- Screens  Cofnponents
/O Search
+ insert - New fereen
B Data B g
» [ fscrvoteForm
B Media 9% icnExit
P ) btnvote
ower Automate * * * ﬁ }{}
Bd imgMarmite
ﬂﬂ Advanced tools rigStars
Jogpe [# biMainTitle
4 D scrResults
[# Label2
ov
+2 lcon3 9% ienExit
The formula bar You can click on this icon to fit the contents of
shows the value of the current screen within its window again, or
current properties. use the slider to zoom in or out.

The Properties window allows you
to see — and change — the
properties of screens and controls.

© Copyright 2023
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Chapter 2 - Creating

Adding (and Moving) Screens

To add a screen: -

1t Power Apps | Canvas

a) Choose to insert a new screen & Back | File |Insert View Action Home Settings

(regardless of what you currently
have selected, Power Apps will insert —
the new screen at the end of the

Ly (] New screen v | Aa Theme~  Open Sans 28

current list of screens). 1
= Blank Scrollable
b) Choose what sort of screen you want — —
(for our app we used Blank for the ¢
first screen and Success for the
second). |
EERREET List Form
° {
LI :
Wik g
4
— Success Tutorial -
Moving Screens
Remarkably, you can’t drag and drop screens to Tree view X

change their order, so instead use this menu:
Screens Components

/O Search

—+ New screen v

B App

> [ scrvoteForm

Click on the [...] symbol and choose to move a L IEucazsiEg T MOVZ.:D

screen up (or down) the list. o9 : -
+g fconCheckl I Duplicate screen

N iconCircle1 =

Training
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What we do!

Basic Advanced Systems /

training training consultancy

Microsoft Excel g gi gid

VBA macros E gé E

Office Scripts E

Microsoft Access EJ
g Power BI and DAX g ¥
g Power Apps g
E Power Automate (both) g gé

sqQL g E g
5 Reporting Services g E g
§ Report Builder g E g
§ Integration Services g E E

Analysis Services E

Visual C# &/J E;J &,J

VB programming &'JJ

MySQL &;J

Python gi E;.{ gJ
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